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Before you begin...

It is recommended that the following items be available to make this short step-by-step
introduction to the Productivity2000 System go smoothly.

Productivity2000 System Example

~

P2-04B Base =

P2-01AC Power Supply )

P2-550 CPU Module AL ‘

PC Running
Windows 7, 8, 8.1

Not available from
Automationdirect.com

Productivity Suite
Programming Software
PS-PGMSW

VAUTOMATIONDIRECT!

Download software from our webste
at: www.automationdirect.com under
“Programmable Controllers”.

Screwdriver
TW-SD-MSL-1

Wire Strippers Hookup Wire

DN-W$S

~ & X
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= fx P2-Fill Module

/\ P2-08TRS Output Module

N P2-08SIM Module

USB-A to Micro USB-B
Programming Cable

AC Power Cord

Not available from
Automationdirect.com.
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Productivity Suite System Requirements
Productivity Suite Windows-based programming software (CD-ROM or web download)
works with Windows® 8 or 8.1 (Home or Professional), or Windows 7 (Home, Professional,
Ultimate, 32 or 64-bit) or Vista® (Home, Basic, Premium, 32 or 64-bit). Please check the
following requirements when choosing your PC configuration:

Vista or Windows 7 or higher Personal Computer with a Windows 8, 8.1 or Windows
10 OS. Personal Computer (Windows Vista) with an 800 MHz or (Windows 7 &
higher) 1GHz processor (CPU) clock speed recommended; Intel Pentium/Celeron
family or AMD K6/Athlon/Duron family, or compatible processor recommended.

SVGA 1024x768 pixels resolution. (1280x1024 pixels resolution recommended).
300MB free hard-disk space.

RAM: Vista or Windows 7 & higher with GUI version 2.0.0.x or higher RAM = 2GB
memory (4GB recommended).

**GUI version 1.10 or lower RAM = 512MB free RAM (1GB recommended).
CD-ROM or DVD drive for installing software from the CD.
USB or Ethernet Port for project transfer to CPU.

. NOTE: USB or Ethernet cable is also required for communications between PC and CPU.
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Step 1: Install Programming Software

¥ AUTOMATIONDIRECT

1. Download the latest version of the Productivity Suite Programming Software from the

Automationdirect website.

Or, if the Productivity Suite Programming Software CD is available, insert it into your PC CD
drive. The install dialog box should appear after a short time.

. Click on the Start menu icon (bottom left corner of screen), and select Run or for Windows 7

users, type “run” in the search field to locate this application.

* Type the following in the Open text field: D: install.exe, where D: is the drive letter of the
CD drive being used, or browse to the location of the “install.exe” file that was downloaded and
selected this file.

* Select OK and follow the dialog boxes shown throughout the next pages.

NOTE: See the Productivity Suite Installation and Productivity Suite Startup topics for additional details if
needed.

3. The “InstallAnywhere” pop-up (shown below) will appear briefly while the software is
preparing to install.

. Instalirpwhere is preparing to install,

L | |
2%

* The progress popup (shown below) will appear while the software is setting up the directory.
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4. Carefully read the software license agreement. If you agree to the terms and conditions of
this agreement, select the “T accept the terms of the License Agreement” and then the “Next”
button.

and Use of Productivity Suite Requires
the Following License Agreement:
AUTCMATIONDIRECT.COM END USER LICENSE
AGREEMENT FOR the Productivity Suite
PROGRAMMING SOFIWARE
IMPORTANT: Before using this software you should
carefully read this agreement. The enclosed

Productivity Suite Programming computer software
programs (the "Softwars") are the property of
Rutomationdirect.com, inc. or its suppliers.
Before installing, copying, downloading, accessing
or otherwise using this package, carefully read
this Agreement. If you do not accept the terms and
conditions of this Agreement, you should return

the enclnsed Snfrware and anv ing items
@ §3o0ept the teme

() | do NOT accept the terms of t

Previous

5. The “Choose Install Folder” window will open next. If this is the first installation of the
Productivity Suite Software on your PC, choose

(a) Install New Instance: This option will install a new instance of the Productivity Suite
software in the default location, C:\Program Files\AutomationDirect\Productivity Suite
<Software Version>; or choose a different one using the Browse button.

Install Option
) Install New Instance
Choose New Folder
[c:\Program Fies (x86)\AutomationDirect\Productivity Suite 2.1.0.15(1) |

Restore Default Browse.
HEplace Existing 'i'nstanua®
2.1.0.16 - C:\Program Files (x36)\AutomationDirect\Productivity Suite 2. 1.(

Change Folder Name
| c:Program Fies (x86)\AutomationDirect Productivity Suite 2.1.0.15 |

Restore Default ” Browse. ]

Note: The existing instance will be uninstalled.

If the installer detects a previous version of Productivity Suite on your PC, there is another option
available with this window:

(b) Replace Existing Instance: This option allows you to uninstall the previous version
of the software and install the new version in its place. If this option is chosen the
following window appears. Click “Uninstall” to continue.

Pr@dUCtiVitsz.“.........Hardware User Manual, 1st Edition, Rev. D 1—5
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Uninstall Productivity Suite

About to uninstall...
Productivity Suite 2.0.0.38

This will rernove features installed by InstallAnywhere. Itwill not
remave files and folders created after the installation.

Please wait while InstallAnywhere's uninstaller removes the following
features...

Files

LaunchAnywheres

Shartcuts/LinksiAliases

Registry Entries

Folders

Others Category

Uninstalling... Productivity Suite 2.0.0.38
| [=

1 —6 I Preductivitym" Hardware User Manual, 1st Edition, Rev. D
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6. Once you have selected the install folder and whether or not to delete any previous
instances, the “Choose Shortcuts” window will appear. If a Shortcut Icon is desired for
the software select the location where the icon will be created. The default location is
“On the Desktop”. Once all selections have been made, click “Install” to begin the installation.

Productivity Suite Programming Software E.__ = @

Where would you like to create product icons?

[] In the Start Menu
0On the Desktop

[] In the Quick Lauch Bar

lcon Name

[Productivity Suite 2.0.0.38 |

Restore Default

A status window will appear displaying the status of the installation.

G TR T T R ==y )
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8. The next screen to appear contains the Release Notes for this version of the Productivity Suite
software. This is an opportunity to review the software version release notes. You may read
these before selecting the “Next” button.

Productivity Suite Release Notes
Version 2.1.0.x

IMPORTANT NOTICES: Using this wersion of
Productivity Suite to save or download a project
created with previous versions may alter the
project and its functionality. Making backup copies
of projects is recommended.

Improvements:

1.) Copy binary option added to Copy Array (CFA)
instruction that copies the bit pattern, ignoring
the numeric value it represents.

2.) New Programmable Limit Switch (PLS) imstruction
added for Px-HSI module that is used to switch
discrete ocutputs ON or OFF based on the position of

Congratulations! Productivity Suite 2.1.0.16(1) has been
successfully installed to:

C:\Program Files (x86)\automationDirect\Productivity Suite
2.1.0.16(1)

Press "Done” to install USE driver and close the installer.

1 —8 I Preductivitym" Hardware User Manual, 1st Edition, Rev. D
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Step 2: Launch Programming Software

After installing the Productivity Suite Programming Software, PS-PGMSW, launch the software
by double clicking the desktop Productivity Suite Icon. Or from the PC’s ‘Start’ menu, slide
the mouse pointer through the menus (start>All Programs>AutomationDirect>Productivity
Suite x.x.x.x>Productivity Suite) to the Productivity Suite Programming Software selection,
and use the left mouse button to click on it.

a)‘« Adobe Acrobat 9 Pro

- Communi-E&

‘ Productivity Suite 2.1.0.16 [ ‘
o
@ Internet Explorer *

The Productivity Suite Programming Software will start up and display the Main Window as
shown here.

NOTE: The recommended minimum screen size for the Productivity Suite Software is 1024 X 786 pixels.

Click on the ‘Start a New Project’ in the Start Productivity dialog box to open a programming
window.

File Edit Setup CPU Tools Window Help

REERE D8 VA I - 3 - 40 - 2 AO4A8 AR
25 offine | .5 Online QChnnseCPuii-:j run 4 stop @ Debug - [l e Y. [ e

Instructions

Application Tools
= | Setup
* & Hardware Config ’ —
=-# Comm Adapter Config
.-l EtherNet/IP Adapter

4., Security Accounts
() Set CPU Time/Date
=~ | Write Program

[ Tag Database
|54 1/ Overview
Rung Comments

& Tag Cross Reference
Eh Compare Project
Monitor & Debug
Data View
Data Logger
PID Tuning

E Compare Contact (CMPi
[# | NC Contact (NC)
| #4f| NC Edge Contact (NCE)
[4F] MO Contact {NO)
|t Lo dge Contact (NOE)

|} starta New Project 1 Open an Existing Project from the CPU

‘ =} Read the Project

PerUCtiVitYZmQ‘: veeeseHardware User Manual, 1st Edition, Rev. D 1 —9
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The Programming Window is divided into menus and toolbars that work together to make
project development as simple as possible.

(e P, ol JRIRI, Ao AN N et TN ey

File Edit Setup CPU Tools Window Help
DUOEDBB|(+B@EONK- b1 e - @ AB4LG ARG
2 offine | - Online ) Choose cPU | @ Run ) Stop @ Debug ~ = (7] ) R ULV, T
| Application Tools | Mew Task @ [#38  Instructions
Eijy Setup g = lTHE (5 er m| - 2 = Favorites
-& Hardware Config =888l S = I}
-8 Comm Adapter Config 1 4 3 G 5 & ? = Contacts
- EtherNet/IP Adapter i - ==,
y ). ¥% | Compare Contact (CMP)
-5 Security Accounts 1 J
() Set CPU Time/Date Application ] [#]ne Coniact i)
b . Write Program | Tools #F | NC Edge Contact (NCE)
|4 Tag Database v e e
=1 1/0 Overview J
Rung Comments & 11| NO Edge Contact (NOE)
QE] Tag Cross Reference
Eﬁ Compare Project 4 I Coils
=} |, Monitor & Debug [16N] Debounce Coil
=] Data View = [FL5]] Flasher
-- g Data Logger 2
PID Tuning [NOF]| Mo Operation
|£2] HS Module Testing & (0] OR Qut
Bit Histogram " 9
Word Histogram ; Instructions [our]| ot Cail
<gd CPU Error History List &.'[E"ul Program End
<@ CPU Event History s [isi]| Reset ol
=+ . Control CPU y .
) Offline £ [3£1] set Coil
- i Online ] [Thc]| Timed Coil
o} choose cPU i
[16¢]| Toggle Coil
-3 Transfer to CPU 10 J
Run = Application Functions
. B n 0| Alarm
8 Debug
WG | Average
Task Management 12 CHG | Change of Value
() New Task 22| Hilité| Find Min Max Values
= |, Tasks 13 LALM| Learn Alarm
. Run First Scan Only UM | Limit Value
Run Every Scan 14 Task Wi R
o Wricw Task | -.4!.-‘\ Management ) e | Ramp
Run Every Second 15 GEN | Ramp Generator
Run When Called 50L | Scale (Linear)
Disable Task L3
18 SCLN| Scale (Mon Linear)
M| Selected Summation

Online Help

It is essential that you use the Productivity Suite online Help to familiarize yourself with the
software. Keep it open on your desktop and refer to it frequently as you build your system.
Click on the toolbar Help button to open the Help file.

1 — 10 I Pr@dUCtiVithggxg",m,mHardware User Manual, 1st Edition, Rev. D
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Step 3: Install Hardware

The Productivity2000 CPU system components snap together to form a configured CPU n
in minutes. See Chapter 5, Installation and Wiring, for more detailed hardware installation
information. What follows are the basic steps:

1. Install power supply in the base and engage locking tab.

2. Install CPU in the base and engage locking tab.

Pr@dUdiVityZMi.........Hardwme User Manual, 1st Edition, Rev. D I 1 - 1 1
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3. Install I/O Modules and engage locking tabs.

[} Locked Unlocked
e - SN

s 4 &
W e

b SN (7 So%e
”'ﬁ? . v c—
| ] ——

——

ST ;i
i
!
-
7 i\
L4

7
/i

/

il

4. Connect appropriate wiring to the power supply (P2-01AC) and I/O (P2-08TRS module) in
this example.

WAUTOMATIONDIRECT:

The power supply and load
are connected through an AC Power Supply
current source.

-Load
To Load l IACL

1 — 12 I \PLDdUCtiVityzm Hardware User Manual, 1st Edition, Rev. D
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5. Connect USB cable. Use a Micro USB cable with a Type A and Micro Type B connectors as
shown below.

Pr@dUCtiVityZM:.........Hardware User Manual, 1st Edition, Rev. D I 1 -— 13
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Ensure proper wiring and the correct voltage is available before connecting wiring to the power
supply. Once this is verified, connect power to the power supply. Once power is applied, the
CPU will perform a self evaluation and verification. See Chapters 2 and 5 of this manual for
more power supply and input wiring information.

n Step 4: Apply Power to CPU

P2-01AC P2-01DCAC
S == ==
Preductivityr........ Productivityis........

'YAUTOMATIONDIRECT:
'WAUTOMATIONDIRECT!

AC(L) +V
AC(N) v
GND GND
LOGIC LOGIC
GND GND

1 — 1'-'- I Pr@dUCtiVit.ngmg",m,mHardware User Manual, 1st Edition, Rev. D
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Step 5: Establish PC to CPU Communications
Select “Choose CPU” icon on the CPU Toolbar and the dialog box shown below will appear.
Highlight the installed CPU listed in the dialog box and select “Connect”.

ﬂ CPU Connections

i i i Add Connection
Connection Device MAC ID User Assigned 1P Address CPU Source CPU

Type Part # CPU Name Connection

USE2.0  P3550  0050c22chfac P3-550 192.168.1.5 Auto-Discovered  Availabl ([ pefete Comnecions |
USB 2.0 [P2-550  [60 520 05 5b db[P2-550 192,168.1.1 Auto-Discovered [ zmport Connections |
Ethernet  P3-550 00 50c22chf9c P3-350 192,168,1.5 Auto-Discovered  Availabl

Export Connections

Start Blinking
CPU Display

Stop Blinking
CPU Display

Change CPU
1P / Name

*in the CPU Source column indicates a connection through a non-CPU module

Connect ][ Cloge ][ Help

When initially going Online with the CPU, a popup window will notify you of a project
difference between the CPU and the PC. Select “No, Use PC Project” command button.

Project Differences =]

&)
& Do youwant to copy the project from the CPU?

The project in the PC workspace is not the same as the one in the CPUL

l Yes, Copy Project From CPU ] l Mo, Use PC Project

Productivitymg;
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Step 6: Open/Read Hardware Configuration

Before we create a project we must configure the hardware so we'll have default input and output
tags for use in our project. With the CPU in “STOP” Mode, select Hardware Configuration
under Application Tools and the following screen opens.

rﬂ Productivity Suite Programming so&
File Edit Setup CPU Tools W
OUHDE &8 @
[ 2 offine | -0 Online ! Cpflose CPU |

Application Tools /
= Setup

iz Hardware Config
Lgm_!aptercong
a EtherMet/IF Adapter
LB, Security Accounts
L-() Set CPU Time Date
- . Write Program
Lef 4 Tag Databasze
= 1/0 Overvi

Hardware Configuration x

ABE > o \
Double-Click the Module to open the

CPU | G5 Drives | EtherNet/IP module configuration page or if manually

adding a module to the system, drag the

@ <4 > desired module to an open slot and the

module’s configuration page will open

automatically.

Local Base Group, Base 1

»

1 H 3 4 5 = CPU

P2-550

|~ Discrete Input
P2-08MNE3
P2-085IM
F2-16NA
P2-16MNE3

= Discrete Output
F2-08TD1P
F2-08TD2P
F2-08TRS

. .

P2-16TD1P

P2-550 PZ-16TA - F2-16TD2P
<l LI 3 F2-16TR

m

1

1 — 16 I Productivi [2000...........Hardware User Manual, 1st Edition, Rev. D
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This screen shows the user tag names for all sixteen I/O points. Select “OK”.

o e == B

16PT QUTPUT, 80-238 VAC

@ Automatic Module Verificatior
() Mo Verification and Enable Hot Swap

Add Default Tags ] [ Remove Default Tags ]

Point User Tagname

1 DO-0.1.1.1 El

2 Do-0.1.1.2

3 DO-0.1.1.3

o DOo-0.1.1.4

5 DO-0.1.1.5 =

=3 Do-0.1.1.6

7 DO-0.1.1.7

3 Do-0.1.1.8

L) Do-0.1.1.9 —

10 Do-0.1.1.10

11 DO-0.1.1.11

12 DO-0.1.1.12 |3
Module Info Manitor ] [ Ok ] [ Cancel ] [ Help ]

Pr@dUCtiVitYZMI.........Hardware User Manual, 1st Edition, Rev. D I 1 -— 17
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n Step 7: Create a Project

We're going to start by entering a simple ladder logic program in the order that follows.
Rung #1

Select the “END” position on Rung #1 with your cursor. From the Instruction List on the
right, scroll down to Counters/Timers section and double click on the Simple Timer (STMR)
instruction. The “Simple Timer” instruction automatically is placed on the selected rung and

the Simple Timer (STMR) dialog box pops up.
1. Enter “T1_SP’ into the Preset Value field.
2. Enter “T1_CURVAL’ into the Current Value field.
3. Enter “T1_DN’ into the Done field.
ElEEREIE o) :Run Every Scan v:‘e\ Monitor «

1 2 3 4 5 & 7 &8 3 10 1

SIMPLE TIMER

L om Tirne Lip }

Preser Value
On Delay

Simple Timer (STMR)

i

[] Use Structure

Ef;;';::;“i T1 8P - E Current Value |T1_CURVAL -

Done |T1_DN -

[--]
(-]
Delay Setting

Time Up
© DnDeley et El‘—'%set
Dane

() Off Delay timer

[] Show Instruction Comment

ok | [ cancel | [ hep

4. Select “OK”.
The Define Tags dialog box opens. Select OK.

5. Enter preset time value of 300ms into “Initial Value” field for Tag T1_SP.

Define Tags

The following tags need to be defined:
String
Description Tag Name Data Type Retentive |l Rows Columns  Initial Value
iCurrent Value T1_CURVAL Integer, 32 Bit ] 0
Done T1DN Boolean B ]
PresetVabe  [TL liieger, 326 1 O

oK ][ Cancel ][ Help

1 — 18 I Pr@dUCtiVithggxg"m,,mHardware User Manual, 1st Edition, Rev. D
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Place the cursor on the first position on Rung #1 as shown below. In the Instruction List
on the right, scroll up to Contacts section and double click on “NO Contact (NO)”. A NO
Contact (NO) is placed at this rung position and a dialog box pops up.

1. Enter “T'1_Start’ into the text box.

2. Select OK.
SIMPLE TIMER
g | Time Up
[ Preset Walue T1_SP Current Walue T1_CURVA,
‘ on Delay Done T1_DN
A 4
r
NO Contact (NO) 5
T —

-1

[] Show Instruction Comment

[ Monitor ] [ oK ] [ Cancel ] [ Help

The Define Tags dialog box opens. Select “OK”.

The following tags need to be defined:
= E String =
Description Tag Name Data Type Retentive 778 Rows Columns  Iritial Value
Input Ti _Start Boolean [} ]
Ok " [ Cancel | [ Hep

Pr@dUCtiVitYZMI.........Hardware User Manual, 1st Edition, Rev. D I 1 -— 19
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With the cursor on Rung #1, to the right of contact “T'1_Start’, we are going to begin drawing
a branch circuit. Under the Edit drop down menu, select “Wire”, then select “Down”. Notice
that a wire has been added.

Productivity Suite Programm
File | Edit | Setup CPU Tools Window Help
g @ Undo Ctrl+Z |g . L83
Dol ™ Redo Ctri+Y | ) Stop @) Debug. = 28 ®:
Appi 4 Cut Crrl+X [oeees
el @ Copy CtleC o i @@ @” o Iﬁ" E—
| @ Paste Cirl+V -
= 1 2 ) 4 S 3]
2| Tag Datab
= et T1_Start
] Rung Comments Ctrl+K |
B Select Rung 3 Q [ '\
Insert 3
Delete > ;
Force 3
Erase with Cursor 3 {
& | Find / Replace Ctrl+F
| Wire bl To Qutput Crl+W
| GoTo Cirl+G Up Ctrl+Up
- | g Bit Histogram 6 | Dawn Ctrl+Down
ik Word Histogram Left Chrle Left
g4 CPU Error Histary . i-= ;
ig§ CPU Event History - | Right Ctrl+Right
]| e—p—
3
Task Management 3
[E] Mew Task [ Edit Selected Task” | [a
=g | Tasks f
&~ 1} Run First Scan Only 10
Ju— r

T1_Start SIMPLE TIMER
® _{ | Time Up| preset value T1_SP Current Value T1_CURVAL
‘ On Delay Done T1_DN

=
{
{ EnD )
{
{ EnD )

NOTE: There is also a wire Erase With Cursor tool in the Edit drop down menu that is used to erase any
lines that were created using the Wire tools.

Hardware User Manual, 1st Edition, Rev. D
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Next we'll draw a wire to the left. Under the Edit drop down menu, select “Wire”, then select
« »
Left”.

T1_Start SIMPLE TIMER
g _{ \ Time Up| preset value T1_SP Current Value T1_CURVAL
\ On Delay Done T1_DN
Z—
{ EnD )

Next we'll add another normally-open contact. Place the box cursor on the first position on the
newly created SubRung #1. From the Instruction List click & drag a Contact (NO) into this
box. A NO Contact (NO) dialog box pops up.

1. Enter “T1_Manual’ into the field.
2. Select “OK”.

T1_Start ‘ STMPLE TIMER.
Time U
f‘_'.?—| I M P! Preset Valus T1_SP Current Value T1 CURVAL
on Delay Done T1_DN

» . 1
NO Contact (NO) 5

)
T1_Manual - E]
[ Show Instruction Comment )
[ Monitor ]| oK |[ Cancel ” Help ] )

The Define Tags dialog box opens. Select “OK”.

, ,

The following tags need to be defined:
String
Description Tag Mame Data Type Retentive Length Rows Columns  Initial Value
Input T1_Manual Boalean ] E
[ [ Cancel ] l Help ]

<. Hardware User Manual, 1st Edition, Rev. D I 1-21
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Rung #2
Next we’ll add another normally-open contact at the start of Rung #2. Click & drag a “NO
Contact (NO)” into this box. A NO Contact (NO) dialog box pops up.

1. In the empty tag field press the down arrow on the right to open a drop-down list; scroll down
and select “T1_DN’.

2. Select “OK”.
T1_Start SIMPLE TIMER.
| Time Up
r.? | Praset Walue T1_SP Current Walue T1_CURWAL
| On Delay Done T1_DM
T1_Manual
7 —
A (e
R.efresh Non-Critical Error Log -
Switch in Run Bit BN )
Switch in Stop Bit
[T1_CURVAL: EMD )
1_Manual ( END )
[T1_SP: =1
IT1_Start - ST

Next we’ll add an Out coil at the end of the rung. Place the cursor at the end of the rung.
From the Instructions list Coil section, double click on an “Out Coil (OUT)”. An Out Coil
(OUT) is placed on the rung and a dialog box pops up.

1. In the tag field press the down arrow on the right to open a drop-down list; scroll down and select

‘DO-0.1.2.1".
2. Select OK.
T1_San SIMPLE TIMER
I T Présed Valua T1_5P  Currend Value T1_CURVAL
ime L
Dane T1_DM
T1_Wanal

HF— ,
TLOH | Qut Coil (OUT) [&J

HH -

EMD

EWMD

aBEml

LA A AL

1 —22 I Pr@dUCtiVithgxxg"m,,mHardware User Manual, 1st Edition, Rev. D
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The ladder program now looks like this. When either of the T1 contacts are energized, the
timer starts. When it times out, contact T1_DN energizes and turns on the rung 2 output.

Ti_San, SIFIPLE TIMER,
I PreseiValue T1_S5F CurentMValue T1_CURWVAL
Tm= L
I Do T1_OM
T1_Manal
T1_OH

Do-0.1.241

o | ¢ oo )

ProduCtiVityzmq:.........Hardware User Manual, 1st Edition, Rev. D I 1—23
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Save the project by opening the File drop-down menu and selecting Save Project.

n Step 8: Save Project

[ File | Edit Setup CPU Tools Window Help
D ! Mew Project
il : Open Project...

| Close Project

|H e Project Ctrl+5
:& Project As...

5 | tmport »

& | Export »

5% | Compile Project F8
Transfer Project k
Page Setup...

@ | Print... Ctrl+P

1—2'-'- I Productivity e ooeenenns Hardware User Manual, 1st Edition, Rev. D
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Step 9: Write Project to CPU

Next we will transfer the project to the CPU. Transfer Project is accessed by selecting Transfer

Project from the File Menu.

Select “To CPU” from the Transfer Project menu.

File | Edit Setup CPU Tools Window Help

MNew Project
Open Project...
Close Project

Save Project
Save Project As...

Import
Export

Ctrl+5

% Monitor -

-

gede T o0

Transfer Project
Page Setup...

Print...

Projes

Compile Project

Ctrl+P

= TEEE 7

Preset Value
On Delay

6 ¥ il 9 10
Time Up

Shift+F9 |
B From cPU... Ctrl+F9

Transfer Project to CPU .

i From Removab[i Nedia... '

The project will then be Transferred to the CPU from the PC. During the transfer a status
window will open displaying the process.

[T )

Compile

Status

In Progress
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Chapter 1: Getting Started

Next, verify the Run/Stop switch on the CPU faceplate is placed in the Run position and
then place the CPU in RUN mode on the Productivity Software Toolbar so the ladder logic

n Step 10: Place CPU in RUN Mode

program executes.

ﬂ Productivity Suite Pregramming Software, Version 2.0.0 (38) [P2 New 5 Timer.adpro]
File Edit Setup CPU Tools Window Help

OO 3 +D0 DN K- R

& Offiine ’m‘ﬁ Choose CPU W‘;ﬁ Stop @ Debug - I W R R,

1 New Task

28 alaEle -

Application Tools

NOTE: If the Run/Stop switch on the CPU is in the Stop position, the Run button on the Programming
Software Toolbar will be disabled.

=4 Offine Mun f-fi Stop | @ Debug -
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Step 11: Test the Project Using Monitor Mode n

In this next step, use the Monitor Mode and Data View to test the ladder logic program. Select
Monitor Mode from the top of the Ladder Logic screen to display the status of Boolean and

Integer Tags.

1 New Task = [P
_] E] E] 1] §] EI ap .EI ” Run Every Scan | & Monitor -(_-

1 2 2 4 & E 7 i 9

T1_Start SIMPLE TIMER
| Tirne Up
1 m | Preset Yalue T1_SP Current Yalue T1_CURWAL
| O Doelay Done T1_DH

Using Data View, the Tag values can be viewed or manipulated for testing the project. The
Data View window can be accessed by selecting Data View from the Tools Menu of the Main
Menu.

For the Simple Timer Instruction, a Monitor button is provided that, when selected, will load
the tags associated with the instruction into Data View.

[] show Instruction Comment

(’/ l oK ” Cancel H Help

r N
Tags Added (oS

I.-"'_"\-.I Tag(s) have been added to data view.,

["] Don't show this dialog again.
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The tags will be placed in a separate Tab titled New Task - STMR as seen below.

Data View %
WD OHK P> W W MDD oswiaying 140042 0%

Data View 1 Mew Task - STMR x | 4 Tags Options

Autoscale Boj
Tagname Mod... ViewAs  Comment Offset Booleans
T1_CLRVAL Decimal ~
= Chart Data

I I O — e

Tise Decimal LI | S —

VR [ —

(SN I ] S ———

(VIR | —

(VNI | S ————

(VT | —

[

(I | e —

[V R 1 | S ———

(T | e ———

0.0
19:00:00.000

The remaining tagnames in the Ladder Logic can be added to the Data View window by
clicking on a blank area in the Tagname column. This will display a drop down menu where
the tags can be selected. Scroll down the list and select the tags to be added.

Data View
Bwl0ond (>l WM D @ vien
DataView 1~ New Task- STMR x 4 Tass

»
Tagname Mod... View As  Comment
T1_CURVAL Decmal -
T1_DNM =)
T1 5P Decimal
| -
T1_DN
[T1_Manual
Ti_sp
[Total Scan Countl
[Total Scan Count2
Was_DO-0.1.2.1 o=
‘Watchdog Timeout -
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Once all of the tagnames

the Data View help file topic for additional details if needed.

have been added, they can now be monitored and manipulated. See

NOTE: Force must be enabled for a Tag in the Tag Database before Force can be used in Data View.

Tag Datat !
|
Tags to show in the Editor
Discrete Inputs  [] Analog Inputs Integers System Data Booleans | comber oct> |
Discrete Outputs 7] Analog Outputs Floats Strings Unused 1/0 [<enter text>
[T Module Status ~ [7] Structures Search Tag Names
1
Editor
Name Type Forceable  Init Forced Init Force Value
DO-0.1.2.13 Discrete Output & & &
D0-0.1.2.14 Discrete Output [l &l [}
DO-0.1.2.15 Discrete Output [l &l [}
DO-0.1.2.16 Discrete Output [l &l [}
T1_CURVAL Integer, 32 Bit [l &l
T1DM Boolean B [l
T1.5P Integer, 32 Bit [l &l
T1_Start Boolean [l B [l
i I T N - B
DO-0.1.2.1 Discrete Output [} [&] [}
[ Add Tags ] [ Delete Tags ]
/ -
Data View %
oY L 11 L IEEEE -
Forceable Tags | Data View 1 | New Task-5TMR |
=1
Tagname Modbus Address View As Comment
T1.DN e
71 tiarua O B —
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Notes:
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